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CS Orthodontic Imaging and CS OMS Im

troduction

u can use this workbook to become acquainted with the 
 Ortho Imaging and CS OMS Imaging software before you are 

ined, while you are training, and after training is finished. 

r more information about using the software, see the 
Orthodontic Imaging Software Online Help and the CS OMS 

aging Software Online Help.

bout This Guide

e following notices, in the sidebar areas of the workbook, 
phasize information or indicate potential risks to personnel and 
uipment: 

Accessing This Guide Electronica

When you install CS Orthodontic or OMS 
electronic version of this guide is installed 

To access this electronic document:

1 On the Microsoft Windows task bar, c

2 Do one of the following:

• Select All Programs > CS Orthod
Online Documentation.

• Select All Programs > CS OMS I
Documentation.

3 Select a document from the drop-dow

The electronic documents are in PDF file fo
opened with Adobe Reader software. If the
software is not installed on your computer:

1 On the Microsoft Windows task bar, c

2 Do one of the following:

• Select All Programs > CS Orthod
Online Documentation > Install 

• Select All Programs > CS OMS I
Documentation > Install Acroba

3 Follow the on-screen instructions to in

arning

arns you to avoid injury 
 yourself or others by 
llowing the safety 
idelines precisely.

CautionCaution
Alerts you to a condition 
that might cause serious 
damage.

portant
lerts you to a 
ndition that might 
use problems.

Note

Provides additional 
information.

ip

rovides extra information 
nd helpful hints.
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Backing Up Data
Back up your data every day. You should have a backup for each 
day of the week, with copies stored off-site. Keep your backups in 
a fire-resistant safe. It is recommended that you work with your 
hardware vendor to create and maintain a backup routine.

Note

Customer Support 
does not provide 
assistance on backup 
procedures. 
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r cursor to the vertical 
isplay area. When the 
 to increase or 

nts button on the 
normal view.

ch visit is identified by 
re for CS Orthodontic 

S Imaging:

Tip

Each item in the TOC 
is called an object.

Table of Contents

Imaging
CS Orthodontic Imaging and CS OMS Im

avigating in the Software

is lesson includes the following topics:

• Accessing the Software

• Using the Image Chart Window

• Using the Tool Box

• Using the Annotations Toolbar

• Using Gallery Edit View

ccessing the Software

u can access the software in two ways:

• In the practice management software, select a patient 
and click the Imaging button.

• In stand-alone mode, double-click the desktop icon for 
the software. The Patient Lookup window is displayed. 
Select the patient and click OK.

e Image Chart window is displayed. 

Using the Image Chart Windo

The Image Chart is the primary workspace
can import, export, display, and enhance im
annotations, make copies, and print images

Using the Table of Contents

The Table of Contents (TOC) tree runs do
window. It displays a patient’s name, a list 
associated with each visit. 

To change the width of the TOC, move you
line that divides the TOC from the primary d
pointer changes to an arrow, click-and-drag
decrease the area displayed. 

To hide the TOC, click the Table of Conte
toolbar. Click the button again to return to 

The TOC is made up of individual visits. Ea
type and date. The following default types a
Imaging: 

• Initial records
• Progress records
• Poor oral hygiene records
• Final records 

The following default types are for CS OM

• Biopsy Consult
• Extraction Consult



Chart Toolbar

e Chart window is the Image Chart toolbar. 
buttons control basic tasks, such as creating 
nging preferences, and viewing images:

 a Visit—Adds a visit to the TOC tree.

ery View menu—Provides a list of options for 
laying images in the Image Chart window. 
ons include:
one—Hides images.
humbnails—Displays miniature versions of 
ll images.
ecords+ and Records—Displays the 
llowing types of images: frontal rest, frontal 

mile, 45 degree smile, profile, and intra-oral.
tra-Oral—Displays only intra-oral images.
rofile & Ceph—Displays a profile photo and 
 corresponding scanned cephalometric 
ray.
anorex—Displays only panoramic images. 

 menu—Increase or decrease the size of 
es. The default value is Fitted. 

e of Contents—Displays and hides the TOC. 

t—Prints images.

il—Creates email messages with the active 
e or gallery attached. 

l Box—Displays and hides the tools available 
e Tool Box. The tools are used to manipulate 
es, to add annotations to images, and to 
painting features.
2 of 8  CS Orthodontic Imaging and CS OMS Imaging Initial Training Workbook (OR150-08)

• Implant Consult
• Post-Operative

Each visit is organized in a tree structure. A plus sign next to a visit 
indicates that images are associated with it. Click the plus sign, 
and a list of the images is displayed. 

The name of the image identifies the type of image: panoramic, 
cephalometric, right buccal, and so on. The following example 
shows a visit in a TOC:

To change the display of images, use the Display Gallery menu. 
To display a single image in the Image Chart window, 
double-click an image. To return to multiple images, click the 
description of the image in the TOC. 

Using the Image 

At the top of the Imag
The following toolbar 
a visit, setting and cha

Tip

To expand the tree, 
click the plus sign. To 
contract the tree, click 
the minus sign. 

Note

If you select an object 
and right-click it, more 
options are available; 
for example, if you use 
CS 3500 or CS 3600, 
you can right-click and 
select Export to 3M to 
send a model.

Add

Gall
disp
Opti
• N
• T

a
• R

fo
s

• In
• P

a
x-

• P

View
imag

Tabl

Prin

Ema
imag

Too
in th
imag
use 
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ol Box icon to display 
CS Orthodontic Imaging and CS OMS Im

Using the Tool Box

With a single image displayed, click the To
the tools. 

Annotations Properties—Displays the 
Annotations toolbar.

Preferences—Opens the Preferences window. 
Default values can be set or edited in this 
window.

Full Screen—Closes the TOC and enlarges the 
images to fit the screen if you select Fitted from 
the View menu. Press any key to return to the 
standard Image Chart window.

With full screen displayed, right-click to see 
other options.

Gripper—Enables you to move an image that is 
larger than the window. The gripper works in 
conjunction with the View menu. It is not active 
unless the zoom percentage is over 100.

Gallery Edit View—Use to edit images in the 
Gallery view. 



e Equalize tool to balance the contrast and 
 an image. It works best on black and white 
. To revert to the original image, click the 
ze tool again.

e Red Eye Reduction tool to reduce the 
e effect in an image.

e Flip tool to rotate an image 180 degrees 
irror it.

e Mirror tool to create a mirror image of your 
l image. To revert to the original image, click 
rror tool again.

e Mask tool to remove part of an image from 
nabling you to show only a section of an 

e Rotate Left tool to rotate an image 
rclockwise in 90-degree increments.

e Rotate Right tool to rotate an image 
ise in 90-degree increments.

e Rotate by Degree tool to rotate an image 
ll, specified increments. To revert to the 
l image, click the Rotate by Degree tool 

e Isodensity tool to display an image so that 
f equal density are the same color. This tool 

rved for intra-oral digital radiography images.

e Densitometric Analysis tool to analyze 
ative density in an image. Depending on the 
st, you can compare two points on the same 

e Select tool to select an object, drag it to a 
cation, or delete it.

e Polygon Line tool to draw an irregular 
or line around an object of interest in an 
4 of 8  CS Orthodontic Imaging and CS OMS Imaging Initial Training Workbook (OR150-08)

Use these Tool Box tools to manipulate and annotate your images: 

Use the Grayscale tool to remove the color from 
an image, creating an image in shades of black and 
white. To revert to the original image, click the 
Grayscale tool again.

Use the Invert tool to invert an image, producing 
an image that looks like the negative of a photo.

Use the Emboss tool to raise the edges of an 
image. 

Use the Brightness tool to increase or decrease 
the brightness of an image. Display an image, click 
the Brightness tool, and use the slider bar to 
adjust the brightness. To revert to the original 
image, click the Brightness tool again.

Use the Contrast tool to adjust the amount of color 
shading in an image. 

Use the Gamma tool to adjust the overall intensity 
of an image. To revert to the original image, click 
the Gamma tool again.

Use the Sharpen tool to define the edges of an 
image. To revert to the original image, click the 
Sharpen tool again.

Use the Median tool to soften an image and 
reduce graininess. To revert to the original image, 
click the Median tool again. 

Use the Despeclkle tool to increase the clarity of 
an image. Click the Despeckle tool, and specks 
are removed from the image. 

Use the Hue tool to change the primary color of an 
image.

Use the Saturation tool to adjust the amount of 
color in an image.

Use th
color in
images
Equali

Use th
red-ey

Use th
and m

Use th
origina
the Mi

Use th
view, e
image.

Use th
counte

Use th
clockw

Use th
by sma
origina
again.

Use th
areas o
is rese

Use th
the rel
contra
image.

Use th
new lo

Use th
shape 
image.
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 to reinforce contrasts 
. This is useful for 
as and detecting 
d hold the mouse 
 the area you want. 
right of the Image 
r increase the size of 

ges tool to create a 
ults.

 your last action. If you 
 click the Undo tool 

rse all your actions.

 access smile 

l to copy a rectangle 
.

o copy a polygon you 

 the lines.

h part of an image.

a change on an image.

 an area.

Note

The icons used to 
adjust paintings are 
disabled unless you 
are working in a 
painting—a copy of an 
image displayed in the 
workspace.
CS Orthodontic Imaging and CS OMS Im

Use the Freehand Draw tool to draw a free-form 
line or shape to emphasize an area in an image.

Use the Line tool to draw a straight line to 
emphasize an area of interest in an image.

Use the Ellipse tool to draw an ellipse or circle 
around an area of interest in an image.

Use the Rectangle tool to draw a rectangle to 
emphasize an area of interest in an image.

Use the Pointer tool to draw an arrow pointing at 
an area of interest in an image.

Use the Text tool to add text to an image. Click the 
Text tool, place the cursor over the image. 
Click-and-drag diagonally to create a text box. Type 
the text. Click outside the box, and the text is 
displayed.

Use the Highlight tool to draw a transparent 
colored box to emphasize an area of interest in an 
image.

Use the Calibrate tool to establish the distance 
between two points in an image. 

Use the Ruler tool to measure an area in an image. 
Calibrate the image before using the ruler.

Use the Protractor tool to measure an angle in an 
image.

Use the Magnifying Glass tool to zoom in on an 
area in the image. 

Use the X-Ray Highlight tool
locally in an area of an image
investigating interproximal are
caries and fractures. Click an
button to activate the tool on
Use the slider at the bottom-
Chart window to decrease o
the highlight. 

Use the Morph to Other Ima
movie showing treatment res

Use the Undo tool to reverse
make a mistake on an image,
before doing anything else.

Use the Undo All tool to reve

Use the Smile Library tool to
images.

Use the Copy Rectangle too
you have drawn on the image

Use the Copy Polygon tool t
have drawn on the image.

Use the Smudge tool to blur

Use the Stretch tool to stretc

Use the Brush tool to brush 

Use the Eraser tool to erase



he Italic button to italicize selected text.

he Underline button to underline selected 

he Increase Font button to increase the font 
 selected text by one point.

he Decrease Font button to decrease the 
e of selected text by one point.

he Font Color button to apply a color to the 
d text.

he Highlight Color button to select the color 
y the Highlight tool.

he Fill Color button to select the color used 
Rectangle tool and Ellipse tool.

he Fill Pattern button to select the fill pattern 
y the Rectangle tool and Ellipse tool.

he Fill Mode button to select the fill mode 
y the Rectangle tool and Ellipse tool. There 
ee fill modes: transparent, opaque, and 
cent.

he Line Width button to select the line width 
y the Line tool and Object tool.

he Line Style button to select the line style 
y the Line tool and Object tool. This button 
 available when the line width is 1 point.

he Line Color button to select the line color 
y the Line tool and Object tool.
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Using the Annotations Toolbar

To create an annotation with a single image displayed, click the 
Text tool. Place the cursor over the image. Click-and-drag diagonally 
to create a text box. Type the text. Click outside the box, and the text is 
displayed.

Use tools in the Tool Box to draw lines and arrows, enclose an 
area of concern, and manipulate the image in different ways.

To change the appearance of the annotation or drawings you 
made, use the tools found on the Annotations toolbar.

With an annotated image displayed, click the Annotations 
Toolbar button to activate the annotation tools. The tools are 
displayed at the bottom of the window: 

These buttons are found on the Annotations Toolbar: 

Use the Region Select tool to outline a region on 
an image.

Use the Paste Region tool to paste from the 
clipboard.

Use the Show Original tool to revert to an original 
image.

Click the Font Properties button to open the Font 
window, where you can change the properties of 
the text.

Click the Bold button to apply bold font style to 
selected text.

Click t

Click t
text

Click t
size of

Click t
font siz

Click t
selecte

Click t
used b

Click t
by the 

Click t
used b

Click t
used b
are thr
translu

Click t
used b

Click t
used b
is only

Click t
used b
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Edit View toolbar. 

 the Gallery Edit View 

Tip

In Gallery Edit view, 
you can display a 
filmstrip and drag an 
image onto it.
CS Orthodontic Imaging and CS OMS Im

Using Gallery Edit View

In the Gallery Edit View window, you can display or hide grid 
lines, change grid lines, and increase or decrease magnification of 
an image.

When multiple images are displayed in the Image Chart window, 
the Gallery Edit View button is activated on the toolbar. Click the 
button to display the Gallery Edit View window. 

In the Gallery Edit View window, click an image to select it. A red 
frame is displayed around the image. 

At the bottom of the Gallery Edit View window is a horizontal 
slider bar that enables you to rotate an image clockwise or 
counter-clockwise to achieve the correct angle. You can also 
rotate an image in increments, reset the angle of the view, and 
undo any changes you have made to the rotation and zoom.

To the right of the Gallery Edit View window is a vertical slider bar 
that enables you to increase or decrease the size of an image.

Below the vertical slider bar is the Gallery 

To return to the Image Chart window, click
button. 

Reset ZoomReset Zoom

Reset Zoom

Reset ZoomReset ZoomReset ZoomHide/Show Lines

Reset ZoomReset ZoomReset ZoomChange Line Color

Reset ZoomReset ZoomReset ZoomSave Lines

Reset ZoomReset ZoomReset ZoomRestore Defaults

Auto Size

Reset ZoomReset ZoomReset ZoomToggle filmstrip

Toggle Frame ID Text



to Gallery Edit View

ou can make adjustments to the images in a 
 in Gallery Edit view.

allery Edit view:

the TOC. If the gallery is Records or 
ages associated with the visit are displayed.

Edit View button. The Image Chart window 
allery Edit View window. Gridlines are 
ult.

Gallery Views 

lay the Records + view. Select the smile 
y itself. Change back to the Records + view.

 views for a visit:

licking on the description in the TOC.

rt window, click the Gallery View menu. A 
displayed. 

cords + option is displayed.

. The images in the Image Chart window 
he Records + layout. 

mile photo. The image is displayed.

rds + layout, click on the visit description in 
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Skill Sharpeners

Exercise 1—Determine the Software Version Number

If you call Customer Support, you must provide the version 
number of the software you are using. 

To determine the version number:

1 In the Image Chart window, right-click the tab with the 
patient’s name. A menu is displayed.

2 Select Help > About Imaging. The About Imaging window 
is displayed. 

3 Make a note of the version number and click Close.

Exercise 2—Change to Full Screen Mode

Expand the Image Chart window so that it fills the entire screen. 
Then return to the normal view.

To expand the Image Chart window and then return to normal 
view:

1 Click the Full Screen button. The Image Chart window 
expands so that it fills the entire screen, and the TOC is no 
longer displayed. 

2 To return to normal view, press Esc.

Exercise 3—Change 

In Gallery Edit view, y
gallery. Display a visit

To display a visit in G

1 Click on a visit in 
Records +, all im

2 Click the Gallery 
changes to the G
displayed by defa

Exercise 4—Change 

Select a visit and disp
photo and display it b

To change the gallery

1 Select a visit by c

2 In the Image Cha
drop-down list is 

3 Scroll until the Re

4 Select Records +
are displayed in t

5 Double-click the s

To return to the Reco
the TOC.



aging Initial Training Workbook (OR150-08)  9 of 14

S

Th

Yo
yo

S

Ce
wi
Or
Gl

OI Global 

d view options

m

t plan 
CS Orthodontic Imaging and CS OMS Im

etting Preferences

is lesson includes the following topics:

• Setting Global Prefences

• Setting Basic Preferences 

• Adding or Changing Your Logo

ur preferences are the default values for the following items in 
ur software:

• Import types and galleries

• Tooth numbering system

• Morphing options

• Painting options

• Location of imported and exported images

• Display and print options

• Color and view options

• Annotation options

• Location of your logo 

etting Global Prefences

rtain default settings are set in the Global Preferences 
ndow. To set them, select Start > All Programs > CS 
thodontic Imaging > Set Global Preferences. The CSOI 
obal Preferences window is displayed.

You can set the following settings in the CS
Preferences window:

• Add/Import—Type and gallery

• Color/View—Background color an

• CS X-Ray—Tooth numbering syste

• Morphing—Quality and frames

• Display—Logo, tabs, and treatmen

• Annotation—Fonts and colors

• Painting—Default options



 also found in the Preferences window:

t—Click this tab, and the Display/Print 
 window is displayed. 

o set the following defaults:

allery

ery

ions
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Setting Basic Preferences

You can set preferences for each workstation, or you can 
standardize preferences for all workstations in the office.

To change preferences or to see the current preferences, in any 
Image Chart window, click the Preferences button. The 
Preferences window is displayed. 

By default, the Preferences window opens with the 
Add/Import/Export tab active. Use this window to set the default 
import folder and the default export folder, among other options.

The following tabs are

• Display/Prin
Preferences

Use this tab t

• Display g

• Print gall

• Print opt

Note

If you acquire x-rays 
from a non- 
Carestream product, 
an additional tab might 
be displayed in the 
Preferences window.

Preferences
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he Colors/View 
 

faults:

colors
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• Annotations—Click this tab, and the Annotations 
Preferences window is displayed. 

Use this tab to set the following defaults:

• Font color, type, and size

• Line color, style, and width

• Highlight color

• Number of times you can click Undo

• Colors/View—Click this tab, and t
Preferences window is displayed.

Use this tab to set the following de

• Display and print background 

• Gallery view and edit options



nging Your Logo

go:

indow, double-click the logo. If you are 
r the first time, double-click Logo 
ble-click to Install. The Add/Update Logo 
ed. 

e Open window is displayed.

t contains your logo and click Open. The 
o window is displayed.

 logo is displayed.

s window, click the Display/Print tab.

not Display Logo option.
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• Scanner—Click this tab, and the Scanner Preferences 
window is displayed. 

Use this tab to set the following default:

• Images to be scanned

• Scanner to use

Adding or Cha

To add or change a lo

1 In the Imaging w
installing a logo fo
Unavailable Dou
window is display

2 Click Browse. Th

3 Select the file tha
Add/Update Log

4 Click Install. The

To display the logo:

1 In the Preference

2 Deselect the Do 

Tip

To display the logo on 
all workstations, install 
it on the server.

Note

The logo file must be in 
.bmp, .cmp, .jpg, .pcs, 
or .tif format.
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references button. 
.

 

k to gray:

references button. 
.

lect Gray.

sizing 

references button.

izing is used, select 
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Skill Sharpeners

Exercise 1—Establish a Default Import Visit Folder

To create a default import folder:

1 In the Image Chart window, click the Preferences button. 
The Preferences window is displayed. 

2 Click the Add/Import/Export tab.

3 In the Default Exp/Imp Visit Folder field, type the path and 
folder name, OR click the Browse button to the right of the 
field and navigate to the folder.

4 Click OK. The path and folder name are displayed in the 
Default Import Folder field. 

Exercise 2—Establish a Default Export Visit Folder

To create a default export folder:

1 In the Image Chart window, click the Preferences button. 
The Preferences window is displayed.

2 Click the Add/Import/Export tab.

3 In the Default Export Folder field, type the path and folder 
name, OR click the Browse button to the right of the field and 
navigate to the correct folder.

4 Click OK. The path and folder name are displayed in the 
Default Exp/Imp Visit Folder field.

Exercise 3—Display Gridlines

To display gridlines:

1 In the Image Chart window, click the P
The Preferences window is displayed

2 Click the Colors/View tab. 

3 Select Show Grid Lines. 

4 Click OK.

Exercise 4—Change Background Colors

To change the background color from blac

1 In the Image Chart window, click the P
The Preferences window is displayed

2 Click the Colors/View tab. 

3 In the Background Colors section, se

4 Click OK.

Exercise 5—Display Instructions for Auto

To display the instructions for autosizing:

1 In the Image Chart window, click the P

2 Click the Colors/View tab.

3 To display the instructions when autos
Show Auto Size Instructions. 
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Exercise 6—Designate a Default Gallery

You can change the gallery layout from Records or Records + to 
Pans or Profile & Ceph or Intraorals, but the view you use most 
often should be displayed when you open the software. This view 
is determined by the default you select in your preferences.

To designate Records as your default gallery view:

1 Click the Preferences button. The Preferences window is 
displayed.

2 Click the Display/Print tab.

3 From the Default Display Gallery drop-down list, select 
Records.

4 Click OK.

Exercise 7—View the Annotation Properties

To examine the current values for annotations:

1 Click the Preferences button. The Preferences window is 
displayed. 

2 Click the Annotations tab. The Annotations window is 
displayed. 

3 View the Font Color field to determine the color used for text.
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dd a Visit button. The 

 select the type. 

t the gallery.

Note

Intraoral screenshots 
selected in the 
acquisition software 
are automatically 
saved in the visit.

Add a Visit
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sing the Software

is lesson includes:

• Creating Visits

• Using Gallery Edit View

• Using the Tools in the Tool Box

• Using the Annotation Tools

• Using the Metal Artifact Reduction (MAR)

• Using the Auto Detect Landmarks Feature

• Working with Images and Documents

• Printing Images

e CS Orthodontic Imaging and CS OMS Imaging software now 
pport the CS 9600 extraoral imaging system. See the online 
lp and the product documentation for more information. 

reating Visits

visit typically consists of two parts: (1) a visit description, which 
ludes the date of the visit, the type of visit, and the gallery used 

 display the images associated with the visit; (2) the images or 
her objects associated with the visit. 

hen you create a visit, you should be ready to import or add the 
ages associated with the visit. 

To create a visit:

1 In the Image Chart window, click the A
Add New Visit window is displayed. 

2 From the Type of Visit drop-down list,

3 From the Gallery drop-down list, selec

4 Click OK. 



 about a visit after the visit was created:

rt window, right-click on the visit 
A short-cut menu is displayed. 

erties. The Visit’s Properties window is 

e of visit, click the drop-down arrow in 
 field, select another type, and click OK.

te, click the navigation button to the right of 
ield. Type a new date and click OK. 
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Deleting Visits

You can delete visits after they have been created, if necessary. To 
delete a visit:

1 In the Image Chart window, right-click on the visit 
date/description. A short-cut menu is displayed. 

2 Select Delete Visit. A messages asks you to confirm the 
deletion. 

3 Click Yes. A message asks if you want to cancel the action. 

4 Click No. 

Editing Visits

To change information

1 In the Image Cha
date/description. 

2 Click Show Prop
displayed. 

3 To change the typ
Change Type To

4 To change the da
the Visit’s Date f

Note

You can also click the 
drop-down arrow and 
select a date from the 
calendar that is 
displayed.
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 the visit to which you 
u is displayed. 

 is displayed. 

Note

In version 11.9 and 
higher, up to five 
intraoral images can 
be generated and 
exported 
automatically.
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Moving Visits

If you accidentally create a visit in the wrong image chart, export 
the visit to a temporary location, open the image chart for the 
correct patient, and import the visit.

To export a visit to a temporary storage location:

1 Open the Image Chart that contains the misplaced visit.

2 Right-click the visit.

3 Select Export. The Select Folder window is displayed.

4 Navigate to the folder in which you want to temporarily store 
the visit. We recommend using a folder on your desktop.

5 Click Select. The visit is exported to the folder you identified.

6 Right-click on the visit in the Table of Contents tree where 
you mistakenly created it, and select Delete.

To import the visit into the correct image chart: 

1 Open the Image Chart for the correct patient.

2 Right-click the patient’s name at the top of the Table of 
Contents tree.

3 Select Import Single Visit, and browse to the location of the 
previously exported visit.

Adding Images 

To add an image to a visit:

1 In the Image Chart window, right-click
want to add an image. A short-cut men

2 Click Add Object. A list of image types



chart associated with a patient:

e imaging software and practice 
ware are closed.

owing:

 All Programs > CS Orthodontic Imaging 
rchive. A message reminds you to close the 

> All Programs > CS OMS Imaging > 
hive. A message reminds you to close the 

age Archive Utility window is displayed. 
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3 Select an image type. The Image Type window is displayed. 

4 Navigate to the image and select it. The image is displayed in 
the Preview pane. 

5 Click Open. The image is added to the visit. 

Deleting Images

To delete an image:

1 In the Table of Contents, right-click the image. A short-cut 
menu is displayed.

2 Select Delete Image. A message asks you to confirm the 
deletion. 

3 Click Yes. A message asks if you want to cancel the action. 

4 Click No.

Archiving Images

To archive the image 

1 Make sure that th
management soft

2 Do one of the foll

• Select Start >
> Imaging A
software.

• Select Start 
Imaging Arc
software.

3 Click OK. The Im

Note

If the image is not 
displayed in the 
Preview pane, make 
sure the Enable 
preview option is 
selected.
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ayed. 

dit View window if you 
rences. To the right of 
lbar. Click the 
ridlines. 

ain to display the 

eturn to the Image 

 gridline and each row 

dit Gallery View 
 is displayed with 

e left ruler where you 

Note

If you are using Gallery 
Edit view, the slider 
bars on the bottom and 
right side are 
inoperable if you are in 
full-screen mode. To 
exit full-screen mode, 
press Esc.

Hide/Show Lines

Gallery Edit View
CS Orthodontic Imaging and CS OMS Im

4 Select the patient number of the patient whose image you 
want to archive.

5 Click Archive. The images are removed from your software. 

A message indicates when the process is complete. 

6 Click OK.

Using Gallery Edit View

In the Gallery Edit View window, you can display or hide gridlines, 
change the gridlines, and increase or decrease magnification of an 
image. 

Displaying and Hiding Gridlines

To display and hide gridlines:

1 Open a visit that contains more than one image. Display it as a 
Records or Records + gallery. 

2 In the Image Chart window, click the Gallery Edit View 
button. 

The Gallery Edit View window is displ

3 Gridlines are displayed in the Gallery E
selected Show Gridlines in your prefe
the Gallery Edit View window is a too
Hide/Show Lines button to hide the g

Click the Hide/Show Lines button ag
gridlines.

4 Click the Gallery Edit View button to r
Chart window.

Adding Gridlines

By default, each column of images has one
of images has one gridline.

To add gridlines: 

1 In the Image Chart window, click the E
button. The Gallery Edit View window
gridlines.

2 To add a horizontal gridline, click on th
want the gridline to be.



s

u to match the size of images. The image 
h is called the source image. The image that 
he target image. 

it View window, click the Auto Size button 

structions window is displayed if you 
n in your preferences. Click OK. 

mage to select it. The frame turns blue.

ts in the source image that will be used by 
he display resolution distance.

image. The frame turns red.

 two points in the target image as you did in 
. The target image is resized. 
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Auto Size

3 To add a vertical gridline, click on the top ruler where you want 
the line to be

4 To remove the extra gridlines, click the Restore Defaults 
button on the Gallery Edit View toolbar. 

Moving Gridlines

To move a gridline:

1 With the gridlines showing in the Gallery Edit View window, 
point at a gridline. The cursor changes to a double-headed 
arrow.

2 Click-and-drag the line to a new position. 

3 To change the gridline to its original position, click the 
Restore Defaults button on the Gallery Edit View toolbar.

Autosizing Image

Autosizing enables yo
that you want to matc
you want to resize is t

To autosize an image:

1 In the Gallery Ed
on the toolbar. 

The Auto Size In
selected the optio

2 Click the source i

3 Click on two poin
the software for t

4 Select the target 

5 Click on the same
the source image

Tip

The source image and 
target image should 
be similar in 
orientation.

Restore Defaults
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u do, the image size 

ge size decreases. 

click the Reset Zoom 

Gallery Edit View
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Changing the Size of an Image

Change the size of an image by using the slider bars in the 
Gallery Edit View window. 

To use the slider bars to change the size of an image:

1 In the Image Chart window, display the images associated 
with a visit.

2 Click the Gallery Edit View button. The Gallery Edit View 
window is displayed. 

3 Click the first image in the top row to select it. The frame turns 
red, and the slider bars are activated. 

4 Move the right-hand slider down. As yo
increases. 

5 Move the slider up. As you do, the ima

6 To return the image to its original size, 
button below the slider bar. 



slider to the right. The image rotates 

slider to the left. The image rotates 
. 

ge to its original position, type 0 in the 
 field on the slider bar at the bottom of the 

s Enter. 
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Rotating an Image

Rotate an image by using the slider bars in the Gallery Edit View 
window. 

To use the slider bars to rotate an image:

1 In the Image Chart window, display the images associated 
with a visit.

2 Click the Gallery Edit View button. The Gallery Edit View 
window is displayed. 

3 Click on the third image in the top row. The frame turns red, 
and the slider bars are activated. 

4 Move the bottom 
clockwise. 

5 Move the bottom 
counterclockwise

6 To restore the ima
Degrees Rotated
window and pres

Note

To rotate the image a 
small amount, click the 
up or down arrows to 
the right of the 
Degrees Rotated 
field.

Gallery Edit View
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displayed.

ge is rotated 90 

Tool Box

Rotate Right

Gripper
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Using the Gripper

If an image is too large to fit in a window, you can use the Gripper 
tool to view parts of the image.

To use the Gripper tool:

1 In the Image Chart window, double-click an image so that it is 
displayed by itself.

2 From the View menu drop-down list, magnify the image by 
selecting a percentage. 

3 Click the Gripper button. The cursor changes to a hand.

4 Click-and-drag the mouse to the right until the left edge of the 
image comes into view. Move the mouse back until the image 
is centered and then release the mouse button.

5 Click-and-drag the mouse up until you can see the bottom of 
the image. Move the mouse back down and then release the 
mouse button.

6 To return the image to its original size, select Fitted from the 
View menu.

Using the Tools in the Tool Box

Using the Tool Box, you can annotate and improve the appearance 
of images. 

Rotating in 90 Degree Increments

To rotate an image:

1 In the Image Chart window, double-click an image. 

2 Click the Tool Box button on the Image Chart toolbar.

The tools on the Tool Box toolbar are 

3 Click the Rotate Right button. The ima
degrees to the right. 



 toolbar, click the Rotate by Degree button. 
ar is displayed at the bottom of the window. 

e clockwise, move the slider to the right; to 
lockwise, move the slider to the left. The 
s you rotate the image is displayed in the 
 the slider bar.

e a specific number of degrees, type the 
 to the right of the slider bar and press 

e a specific number of degrees 
, type a minus number in the box to the right 

nd press Enter.

ge to its original orientation, click the Show 
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4 Click the Rotate Right button again. The image has been 
rotated 180 degrees. 

5 To return the image to its original orientation, click the Show 
Original button. 

Rotating an Image by Degrees

To rotate an image in uneven increments:

1 In the Image Chart window, double-click an image. 

2 On the Tool Box
The Rotate toolb

3 To rotate the imag
rotate it counterc
number of degree
box to the right of

To rotate an imag
number in the box
Enter. 

To rotate an imag
counter-clockwise
of the slider bar a

4 To restore the ima
Original button. 

Tip

To rotate an image a 
specific number of 
degrees counter- 
clockwise, type a 
minus sign before the 
number.

Rotate by Degree

Show Original
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 Percentage field,

the new contrast.

 Contrast button 

Contrast

Brightness
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Changing Brightness

The Brightness tool enables you to increase or decrease the 
brightness of an image.

To change the brightness of an image:

1 In the Image Chart window, double-click an image. 

2 On the Tool Box toolbar, click the Brightness button. The 
Brightness window is displayed. 

3 Move the slider or type a number in the Percentage field. 

4 Click OK. The image is displayed with the enhanced 
brightness. 

5 To revert to the original level of brightness, click the 
Brightness button again.

Using the Contrast Tool

You can change the contrast of an image b
Contrast tool makes the whites whiter and

To use the Contrast tool:

1 In the Image Chart window, double-cl

2 On the Tool Box toolbar, click the Con
Contrast window is displayed. 

3 Move the slider or type a number in the

4 Click OK. The image is displayed with 

5 To revert to the original image, click the
again.



s in the Channel fields, and click OK. The 
 displayed. 

efault value of 1.0, click the Gamma button 

a value:

 toolbar, click the Gamma button. The 
ent window is displayed.

s to minus numbers, and click OK. The 
 displayed. 

amma value of 1.0, click the Gamma button 

age

rpens the pixels and changes the definition 
ge. 

rt window, double-click an image. 
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Changing the Intensity of an Image

The Gamma tool adjusts the overall intensity of an image. The 
Gamma tool combines the effects of the Brightness tool and the 
Contrast tool.

To increase the gamma value:

1 In the Image Chart window, double-click an image.

2 On the Tool Box toolbar, click the Gamma button. The 
Gamma Adjustment window is displayed. 

3 Change the value
modified image is

4 To revert to the d
again. 

To decrease the gamm

1 On the Tool Box
Gamma Adjustm

2 Change the value
modified image is

3 To revert to the g
again.

Sharpening an Im

The Sharpen tool sha
of the edges of an ima

To sharpen an image:

1 In the Image Cha

Note

The Gamma tool is not 
available with digital 
images.

Note

You cannot sharpen an 
out-of-focus image. If the 
image is blurry, acquire 
the image again.

Gamma
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lor of an image. 
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 button. The Hue 

 Angle (degrees) field. 

yed.

 Hue button again.

Hue

Sharpen
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2 On the Tool Box toolbar, click the Sharpen button. The 
Sharpen window is displayed. 

3 Move the slider or type a number in the percentage field. 

4 Click OK. The modified image is displayed.

5 To revert to the original image, click the Sharpen button 
again.

Changing the Hue

The Hue tool changes the predominant co

To change the hue of an image:

1 In the Image Chart window, display a 

2 On the Tool Box toolbar, click the Hue
window is displayed. 

3 Move the slider or type a number in the

4 Click OK. The modified image is displa

5 To revert to the original image, click the



st and Color

ances the contrast and color in an image. 

st and color in a black-and-white image:

rt window, display a black-and-white image. 

toolbar, click the Equalize button. The color 
utomatically adjusted. 

riginal image, click the Equalize button 
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Changing the Saturation Levels

The Saturation tool adjusts the amount of color in an image. 

To change saturation levels in an image:

1 In the Image Chart window, display a color image.

2 On the Tool Box toolbar, click the Saturation button. The 
Saturation window is displayed. 

3 Move the slider or type a number in the Percentage field. 

4 Click OK. The modified image is displayed.

5 To revert to the original image, click the Saturation button 
again.

Balancing Contra

The Equalize tool bal

To balance the contra

1 In the Image Cha

2 On the Tool Box 
and contrast are a

3 To revert to the o
again.

Equalize

Saturation
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ian button. 

 click OK. A modified, 

 Median button again.

age. Embossing can 
ue and soft tissue.

 image.

boss button. The 

Note

When photos taken 
with a high-resolution 
camera are displayed 
on a flat panel monitor, 
they appear grainy or 
pixelated. The Median 
tool corrects this 
condition.

Median

Despeckle

Emboss
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Using the Despeckle Tool

The Despeckle tool improves the clarity of a photograph by 
removing specks.

To use the Despeckle tool:

1 In the Image Chart window, display a photo with specks. 

2 On the Tool Box toolbar, click the Despeckle button. The 
specks are removed from the image. 

3 To revert to the original image, click the Despeckle button 
again.

Using the Median Tool

The Median tool softens an image and can reduce graininess. The 
default value of the Median tool is 3, which is the lowest setting, 
but you can increase the value to 11. 

To use the Median tool:

1 In the Image Chart window, display an image. 

2 On the Tool Box toolbar, click the Med
The Median window is displayed. 

3 Enter 10 in the Sample size field, and
softer image is displayed.

4 To revert to the original image, click the

Using the Emboss Tool

The Emboss tool raises the edges of an im
help to show differences between hard tiss

To use the Emboss tool:

1 In the Image Chart window, display an

2 On the Tool Box toolbar, click the Em
Emboss window is displayed. 



 toolbar, click the Masking button. The 
 a crosshair.

left 1, 2, and 3 teeth by clicking-and- 
ound them.

 box around the target, release the mouse 

riginal image, click the Masking button 

ol

own, use the Flip tool to flip the image from 

rt window, display an image. 
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3 In the Direction field, select the direction of the emboss. 

4 Use the slider or type the amount of depth in the Depth field. 

5 Click OK. The embossed image is displayed. 

6 To revert to the original image, click the Emboss button again.

Using the Masking Tool

The Masking tool is used to select a part of an image. 

To mask part of an image:

1 In the Image Chart window, display an image. 

2 On the Tool Box
cursor changes to

3 Select the upper-
dragging a box ar

When you have a
button. 

4 To revert to the o
again.

Using the Flip To

If an image is upside d
top to bottom.

To flip an image:

1 In the Image Cha

Masking 
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a negative—white 
Use the Invert tool to 
oft tissue.

 x-ray image. 

rt button. The image is 

 Invert button again. 

Flip

Mirror

Invert
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2 On the Tool Box toolbar, click the Flip button. The image is 
inverted. 

Using the Mirror Tool

If an image needs to be reversed, use the Mirror tool.

To produce a mirror image:

1 In the Image Chart window, display the image to be reversed. 

2 On the Tool Box toolbar, click the Mirror button. The image is 
reversed. 

Using the Invert Tool

The Invert tool makes an image appear as 
becomes black and black becomes white. 
help distinguish between hard tissue and s

To use the Invert tool:

1 In the Image Chart window, display an

2 On the Tool Box toolbar, click the Inve
inverted. 

3 To revert to the original image, click the



ol

rt window, display an image. 

 toolbar, click the Text button. The cursor 
shair.

o where you want the text to start, 
 cursor diagonally down. The text box is 

mple text. 

e text box, and it turns white. This indicates 
r text.
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Using the Grayscale Tool

If you scan a cephalometric image, it might display bluish tints. 
Use the Grayscale tool to remove color in an image. 

To use the Grayscale tool:

1 In the Image Chart window, display an image from which you 
want to remove the color.

2 Click the Grayscale button. The image is displayed in shades 
of gray.

Using the Annotation Tools

You can use the following tools to annotate images:

• Text—Enables you to add words to an image. 

• Pointer—Enables you to draw arrows on an image. 

• Rectangle—Enables you to draw a rectangle around an 
area in an image.

• Ellipse—Enables you to draw an ellipse or circle around 
an area in an image.

• Polygon—Enables you to draw a polygon around an area 
in an image.

• Line—Enables you to draw straight lines on an image.

• Freehand—Enables you to draw irregular lines on an 
image.

All of the annotation tools can be used in combination with each 
other. You can hide the annotations and display them again later. 
You can change the properties of the annotation tools—line 
thickness, font size, colors, and so on—with the Annotation 
Properties toolbar.

Using the Text To

To add an annotation:

1 In the Image Cha

2 On the Tool Box
changes to a cros

3 Move the cursor t
click-and-drag the
displayed with sa

4 Double-click on th
that you can ente

Grayscale

Text
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lick the image identifier 
yed. 

image identifier, and 

ted image to display it 

e annotations to be 
x and once on each 

Note

To delete all of the 
annotations you 
made, open the Tool 
Box and click Undo 
All.

Polygon
CS Orthodontic Imaging and CS OMS Im

5 Click in the text box, and type the text you want to be 
displayed on the image. 

Drawing Polygons

To draw a polygon:

1 On the Tool Box toolbar, click the Polygon button. The cursor 
changes to a crosshair.

2 Click-and-drag the cursor to form the first side of the polygon. 

3 Click again to indicate the end of the first side and the start of 
the second side.

4 Continue to draw sides until the polygon is complete.

5 Double-click to finish; click once anywhere in the image to 
establish the polygon. 

Hiding Annotations

To hide annotations:

1 With an annotated image open, right-c
in the TOC. A short-cut menu is displa

2 Click Hide Annotations.

3 To see the annotations, right-click the 
select Show Annotations.

Deleting Annotations

To delete annotations:

1 In gallery view, double-click the annota
by itself. 

2 Hold down the Shift key, and select th
deleted by clicking once on the text bo
arrow. 



 Detect Landmarks Feature

 Detect Landmarks feature to identify and 
 landmark structures automatically on 
 acquired by the CS 9000, CS 9300, and 

utomatically on a cephalometric image:

-ray of an image in the Digitizing/Editing 

 toolbar, click the Auto Detect Landmarks 
 points are digitized, editing details are 
uide tab of the Digitizing/Editing window.

ark for accuracy. If you need to edit it, 
 landmark to a new position.

e intended to support diagnoses. Typically, 
ify up to three or more points on each image 
ccurate.
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3 Right-click, and a shortcut menu is displayed. 

4 Click Delete.

Using the Metal Artifact Reduction (MAR)

CS Orthodontic Imaging and CS OMS Imaging, versions 11.9 
and higher, include CS MAR, an algorithm that improves image 
quality by reducing the distortion caused by metal from objects 
such as prostheses, screws, or dental filings. You can compare 
images with and without the MAR filter to increase the accuracy of 
diagnoses. 

To apply the MAR filter to regular 3D volumes:

1 In the Table of Contents pane, right-click the volume and 
select Launch MAR Reconstruction.

2 To view the volume, right-click it and select Launch Object. 
When the volume is displayed, use the CS MAR button in the 
Adjustments pane to toggle between the filtered and 
unfiltered views.

To export a MAR volume, right-click it and select Export. 

To delete a MAR volume, right-click it and select Delete Object.

Using the Auto

You can use the Auto
outline anatomical and
cephalometric images
CS 9600.

To detect landmarks a

1 Display a lateral x
window.

2 On the Digitizing
button. When the
displayed on the G

3 Review the landm
click-and-drag the

4 Click Done.

Automatic tracings ar
you may need to mod
for the tracing to be a

Tip

To conserve hard 
drive space, use MAR 
on an as-needed 
basis.

CS MAR

Auto Detect Landmarks
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t Single object. The 

 the image that you 

 Bitmap and Print to 

elect an option in the 

Tip

You can send multiple 
images as separate 
.jpg files.

Print
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Working with Images and Documents

You can copy images to documents and attach images to email 
messages.

Copying Images

To copy an image to a document:

1 In the TOC, right-click the image you want to copy. A short-cut 
menu is displayed. 

2 Click Copy.

3 Open a Microsoft Word document and select Paste. 

Attaching Images

To attach an image to an email message:

1 Select the visit containing the image you want.

2 Click the Print button. The Print window is displayed. 

3 From the Gallery drop-down list, selec
Object field is activated.

4 From the Object drop-down list, select
want. 

5 In the Redirect to field, select Print to
Email.

6 To print the image at a different size, s
Scaling field.

7 Click Print. 



s

ages or all of the images in a gallery. 

ages

 to print.

tton. The Print window is displayed. 

ns, if necessary. 

Images

es:

images.

tton. The Print window is displayed. 

ns, if necessary.
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8 Switch to your email application, and an email is displayed 
with the subject line filled in and the image attached. 
Double-click on the attachment to see the image. 

9 Enter information in the To: field and send the message.

Printing Image

You can print single im

Printing Single Im

To print an image:

1 Display the image

2 Click the Print bu

3 Change any optio

4 Click Print. 

Printing Multiple 

To print multiple imag

1 Display all of the 

2 Click the Print bu

3 Change any optio

4 Click Print.

Note

You cannot print 
random images at one 
time.

Print
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 window is displayed. 

ures window is 

andscape.

Print
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Changing the Orientation of Images

To change the orientation of a page:

1 Select an image to print.

2 Click the Print button. The Print window is displayed. 

3 Click Print Setup. 

4 Click Properties. The Print Properties

5 Click the Features tab. The Print Feat
displayed. 

6 In the Basic Options section, select L
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7 Click OK. The Print Setup window is displayed.

8 Click OK. The Print window is displayed.

9 Click Print. 

Printing a Date of Birth on Images

To print a patient’s date of birth on images:

1 Click the Preferences button. The Preferences window is 
displayed. 

2 Click the Display/Print tab. 

3 Select the Print Birthdate option.

4 Click OK.

Tip

You can also print the 
name of your practice 
on images.

Preferences
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art: 
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p of the Table of 

e to the location of the 
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Skill Sharpeners

Exercise 1—Create a Visit

Create a new visit for progress records. To create a new visit:

1 In the Image Chart window, click the Add a Visit button. The 
Add New Visit window is displayed. 

2 From the Type of Visit drop-down list, select Progress 
Records. 

3 Change the date in the Description field to one for images 
taken three months ago.

4 From the Gallery drop-down list, select Records.

5 Click OK. 

Exercise 2—Change the Date

To change the date of a visit after the visit was created:

1 Right-click on the visit date/description. A short-cut menu is 
displayed. 

2 Click Show Properties. The Visit’s Properties window is 
displayed. 

3 Click the navigation button to the right of the Visit’s Date 
field. The Select Date window is displayed. 

4 Type a new date and click OK. The Select Date window is 
displayed again with the new date. 

5 Click OK. The software recreates the visit with the new date. 

6 Click OK. 

Exercise 3—Move a Visit to Another Imag

Because you have accidentally created a v
you must move it to a temporary location, o
the correct patient, and import the visit.

To export a visit to a temporary storage loc

1 Open the Image Chart that contains t

2 Right-click the visit.

3 Select Export Visit. The Browse for F
displayed.

4 Navigate to the folder in which you wa
the visit. 

5 Click Select. The visit is exported to th

6 Right-click on the incorrect visit in the T
select Delete.

To import the visit into the correct image ch

1 Open the Image Chart for the correct

2 Right-click the patient’s name at the to
Contents.

3 Select Import Single Visit, and brows
previously exported visit.



ype. The Add Image window is displayed. 

age and select it. The image is displayed in 
. 

image is added to the visit. 

an Image

ive the image chart. In the next exercise, 

chart associated with a patient:

e imaging software and practice 
ware are closed.

owing:

 All Programs > CS Orthodontic Imaging 
rchive. A message reminds you to close the 

> All Programs > CS OMS Imaging > 
hive. A message reminds you to close the 

age Archive Utility window is displayed. 

t’s image chart to archive by selecting the 
the patient number.

e images are removed from your software, 
dicates when the process is complete. 
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Exercise 4—Move an Image to Another Visit

Move an image from one visit to another in the same Image Chart 
window. Then move it back.

To move an image from one visit to another:

1 Expand the Table of Contents so that the description of the 
image you want to move is displayed.

2 Right-click the image. A short-cut menu is displayed. 

3 Click Copy. 

4 Right-click the visit to which you want to move the image. A 
short-cut menu is displayed.

5 Click Paste. 

To move the image back to its original visit: 

1 Right-click the image. A short-cut menu is displayed.

2 Click Cut. 

3 Right-click the visit to which you want to move the image. A 
short-cut menu is displayed.

4 Click Paste. 

Exercise 5—Add an Image to a Visit

To add an image to a visit:

1 Right-click the visit to which you want to add an image. A 
short-cut menu is displayed. 

2 Point the cursor to Add. A list of image types is displayed. 

3 Select an image t

4 Navigate to the im
the Preview pane

5 Click Open. The 

Exercise 6—Archive 

Select a visit and arch
restore the visit.

To archive the image 

1 Make sure that th
management soft

2 Do one of the foll

• Select Start >
> Imaging A
software.

• Select Start 
Imaging Arc
software.

3 Click OK. The Im

4 Select the patien
checkbox before 

5 Click Archive. Th
and a message in

6 Click OK.
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Exercise 7—Restore an Image from an Archive

Restore the visit that you archived in the preceding exercise.

To restore archived images:

1 Select the patient in your practice management software.

2 Click the Imaging button. The Restore Patient window is 
displayed, and the Location of media field indicates the 
archive location. 

3 Click OK. The patient and associated images are restored to 
the imaging software. A message indicates when the process 
is complete.

4 Click OK.

Exercise 8—Display Images as Thumbnails

To display images as thumbnails:

1 With a group of images displayed, click the Gallery View 
drop-down list. 

2 Use the scrollbar on the right side of the list, and scroll up 
until Thumbnails is displayed.

3 Click Thumbnails. The images in the Image Chart window 
are displayed as thumbnails. 

Exercise 9—Change the Size of an Individual Image

Display a photo and reduce it by 125 percent. Return the photo to 
its original size. 

To change the size of an image:

1 In the Image Chart window, double-click an image so that it is 
displayed by itself.

2 From the View menu drop-down list, select 125%. 

3 To return the image to its original size, 
View menu.

Exercise 10—Display Two Images Side b

You want to show the patient the profile ph
visit next to the profile photo taken in the fin

To display two images side by side:

1 Right-click the title of the profile image
visit in the TOC. A short-cut menu is di

2 Select Side compare to . . . > Final R
two images are displayed side by side

3 To close the side-by-side display, click
TOC.

Exercise 11—Display Two Images Vertic

Compare two images, one above the other

To compare two images vertically:

1 Right-click the title of the profile image
visit in the TOC. A short-cut menu is di

2 Select Top compare to . . .> Type_of_
Type_of_Image. The two images are d
image on top and the second one belo

3 From the View menu, select 50%. 

4 To return the photo to its original size, 
View menu. 

5 To return to gallery view, double-click t



 Brightness

anges to an image:

brightness by 25 percent.

 original value.

 brightness by 25 percent.

 original value.

ess of an image:

rt window, double-click an image. 

 toolbar, click the Brightness button. The 
ss window is displayed. 

rcentage field. The image preview is 
ent brighter. 

ge is displayed with the enhanced 

riginal level of brightness, click the 
n again.

ess button again. The Change Brightness 
ed.

ercentage field. The preview pane shows 
 percent decrease in brightness.

ge is displayed with the reduction in 

riginal level of brightness, click the 
n again. 
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Exercise 12—Rotate an Image by Degrees

Rotate an image 27 degrees. Then rotate it 17 additional degrees, 
for a total of 44 degrees. Then return the image to its original 
position.

To rotate an image in uneven increments:

1 In the Image Chart window, double-click an image. 

2 On the Tool Box toolbar, click the Rotate by Degree button. 
The Rotate toolbar is displayed at the bottom of the window. 

3 To rotate the image clockwise, move the slider to the right; to 
rotate it counterclockwise, move the slider to the left. The 
number of degrees you rotate the image is displayed in the 
box to the right of the slider bar.

To rotate an image a specific number of degrees, type the 
number in the box to the right of the slider bar and press 
Enter. In this instance, type 27 and press Enter. The image 
rotates 27 degrees. 

4 To rotate the image an additional 17 degrees, type 44, the 
sum of 27 and 17, and press Enter. The image has now been 
rotated 44 degrees. 

5 To restore the image to its original orientation, click the Show 
Original button. 

Exercise 13—Change

Make the following ch

• Increase the 

• Revert to the

• Decrease the

• Revert to the

To change the brightn

1 In the Image Cha

2 On the Tool Box
Change Brightne

3 Type 25 in the Pe
displayed 25 perc

4 Click OK. The ima
brightness. 

5 To revert to the o
Brightness butto

6 Click the Brightn
window is display

7 Type -25 in the P
the effect of a 25

8 Click OK. The ima
brightness.

9 To revert to the o
Brightness butto
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Exercise 14—Change the Intensity of an Image

Make the following changes to an image:

• Increase the gamma value to 3.0. 

• Revert to the original value. 

• Decrease the gamma value to minus 0.5.

• Revert to the original value.

To increase the gamma value to 3.0:

1 In the Image Chart window, double-click an image.

2 On the Tool Box toolbar, click the Gamma button. The 
Gamma Adjustment window is displayed. 

3 Type 3.0 in the Value field, and click OK. The modified image 
is displayed. 

4 To revert to the default value of 1.0, click the Gamma button 
again. 

To decrease the gamma value to 0.5:

1 On the Tool Box toolbar, click the Gamma button. The 
Gamma Adjustment window is displayed.

2 Change the gamma value to 0.5, and click OK. The adjusted 
image is displayed. 

3 To revert to the gamma value of 1.0, click the Gamma button 
again.

Exercise 15—Sharpen an Image

Select an image, and sharpen it by 100 per
original sharpness. 

To sharpen an image:

1 Double-click an image. 

2 On the Tool Box toolbar, click the Sha
Sharpen window is displayed. 

3 Type 100 in the percentage field, and v
preview pane. 

4 To see the full image, click OK.

5 To revert to the original image, click the
again.

Exercise 16—Change the Hue of an Imag

Change the hue of an image. Then revert to

To change the hue of an image:

1 Display a color image.

2 On the Tool Box toolbar, click the Hue
Hue window is displayed. 

3 Enter a value in the Angle (degrees) f
bar to adjust the hue. 

4 When you have the hue that you want,

5 To revert to the original image, click the



left 1, 2, and 3 teeth by holding down the left 
 dragging a box around them.

 box around the target, release the mouse 

riginal image, click the Masking button 

e Color from a Cephalometric Image

ic image, and apply the Grayscale tool.

 tool:

.

le button. The image is displayed in shades 

aphic Elements to an Annotation

rt of an annotation. Point the arrows from the 
 gum line.

nnotation:

 with an annotation.

toolbar, click the Pointer button. The cursor 
shair.

e cursor to the text box. The arrow has a 
 end, which means that the arrow can be 
ete if the arrow is unsatisfactory.

he arrow, click off of it. 

 tool again. The cursor changes to a 

 create the second arrow. 
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Exercise 17—Change the Clarity of an Image

Apply the Despeckle tool to a frontal smile photo.

To use the Despeckle tool:

1 Display a frontal smile photo. 

2 On the Tool Box toolbar, click the Despeckle button. The 
specks are removed from the image. 

3 To revert to the original image, click the Despeckle button 
again.

Exercise 18—Use the Median Tool

Apply the Median tool to a profile photo, changing from a default 
value of 3 to 10. 

To use the Median tool:

1 Display a profile photo. 

2 On the Tool Box toolbar, click the Median button. The 
Median window is displayed. 

3 Enter 10 in the Sample size field, and click OK. A modified, 
softer image is displayed.

4 To revert to the original image, click the Median button again.

Exercise 19—Select Part of an Image

Display an upper occlusal, and mask it so that only the upper-left 
1, 2, and 3 teeth are displayed.

To mask part of an image:

1 Display an upper occlusal by itself. 

2 On the Tool Box toolbar, click the Masking button. The 
cursor changes to a crosshair.

3 Select the upper-
mouse button and

4 When you have a
button. 

5 To revert to the o
again.

Exercise 20—Remov

Select a cephalometr

To use the Grayscale

1 Display an image

2 Click the Graysca
of gray.

Exercise 21—Add Gr

Add two arrows as pa
text you created to the

To add arrows to an a

1 Display an image

2 On the Tool Box 
changes to a cros

3 Click-and-drag th
white box at each
edited. Press Del

4 To stop drawing t

5 Click the Pointer
crosshair.

6 Click-and-drag to

Tip

Click where you want 
the arrow head and 
then drag towards the 
end of the arrow.
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Exercise 22—Change Annotation Properties

Change the colors of arrows.

To change the colors of arrows:

1 In an annotated image displaying arrows, click one of the 
arrows. The arrow is displayed with a small white box at either 
end. 

2 Click the Annotations’ Properties button on the toolbar at 
the top of the window. The Annotations Properties toolbar is 
displayed at the bottom of the window. 

3 Click the Line Color button. The Color window is displayed. 

4 Select yellow and click OK.

5 Repeat the process to make the second arrow yellow. 
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dmark list, the Close Up window presents a 
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, thereby suggesting a three-dimensional look.

another folder while leaving the image in the 

es contained in a single visit; a particular layout.

layed simultaneously in the Image Chart window.
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lossary

solute Template
emplate drawn directly on an x-ray without regard to landmarks.

D
ch length discrepancy, as measured in millimeters.

chive
oring all of the images associated with a patient in another location, typically in 
ocation that is not on your PC. Archived images can be restored into the 
ftware, if necessary.

tosizing
unction that enables you to change the size of an image so that it will match 
 size of another image. 

tch Acquisition
porting all bitmap and movie files from a designated import folder into the 
ftware.

tmap
tandard format for the display of images on a computer screen. The image is 
resented by columns and rows of dots. The more dots per square inch (DPI), 
 better the resolution of an image on the screen. 

owse Button
icated by a rectangle with three dots on it, click the Browse button to look 
ough the software for a particular file or folder.

libration
e process of verifying, and adjusting to, measurements on an image.

Clipboard
A temporary holding area for m
contents of the clipboard are p
pasted, however, remains on th
several places without having t

Close Up Window
Located to the right of the Lan
magnified view of the area und

CPI
Condular positioning index.

CR
Computed radiograph.

DR
Digital radiograph.

Emboss
To raise the edges of an image

Export
To send a copy of an image to 
original folder.

Gallery
An arrangement of patient imag

Gallery View
When multiple images are disp



ndmarks, such as the distance between two 
hree landmarks.

age, the white boxes that are displayed are 
 object, click on a node and drag it.
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l image, audio, movie, text documents.

 displayed in the Image workspace.

nder, ID assigned by your practice, and race. 
’s Properties window.

picture is a function of the number of pixels.

 which the page is longer than it is wide. See 

late various stages of treatment. Images from 
 to a patient’s image to show possible 
 cannot be used until it has been populated 

tracing.
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Gamma
The unit of measure for the intensity of an image. Use the Gamma tool to adjust 
the intensity of an image.

Gridlines
Use gridlines to align images in the Gallery Edit View window. By default, there 
is one gridline for each row of images and one gridline for each column of 
images.

Gripper
Found on the Image window toolbar, the Gripper tool is used to navigate an 
image that is larger than the screen.

Histogram
Bar graph that expresses the distribution of light in an image.

Import
To bring an existing image into the software. The Import function attaches a 
single image to the image chart without launching the associated equipment.

Isodensity Line
Areas of equal density shown as a single color on intraoral images.

Landmark
A point entered on an image that is used in measuring. The tip of the upper 
incisor is a typical measurement.

Landscape
The orientation of a printed page in which the page is wider than it is long. See 
portrait orientation.

MAPI-Enabled Software
An acronym for Messaging Application Programming Interface, MAPI is built into 
Microsoft Windows operating systems. The software enables email applications 
to work together to distribute email. You must have MAPI-enabled software to 
use the Print to Email option in the CS orthodontic or OMS imaging software.

MAR
A metal artifact reduction filter, available for 3D exams. The feature reduces the 
scatter caused by metal in a patient’s mouth.

Mask
To hide part of an image.

Measurement
A mathematical calculation using la
landmarks or the angle defined by t

Node
When an object is selected in an im
the nodes. To change the size of an

Object
Any file associated with a patient vi
bitmap, painting, x-ray image, digita

Painting
A copy of an image that is currently

Patient Demographics
The patient’s name, date of birth, ge
These are displayed on the Patient

Pixel
Pictorial element. The clarity of the 

Portrait
The orientation of a printed page in
landscape orientation.

Smile Library
A collection of images used to simu
the Smile Library can be pasted on
treatment results. The Smile Library
with images from existing cases.

STO
Surgical treatment objective.

Superimposition
A tracing placed on top of another 



aging Initial Training Workbook (OR150-08) 49 of 50
<Akzidenz9>CS Orthodontic Imaging and CS OMS Im

Table of Contents 
The column that runs down the left side of the Image Chart window. The TOC 
presents a history of a patient’s visits with the images associated with each 
image. Each visit is date and time stamped.

Template
For the purposes of this software, a drawing that represents an anatomic 
structure. Templates are composed of one or more parts, each part containing 
one or more points. Parts are used to draw separate components of the 
template.

Thumbnail
A small version of an image. Thumbnails are the default gallery for automatic 
visits. Thumbnail images load faster than larger images.

Visit 
In this software, each visit is typically a record of a one patient appointment. Each 
visit is date and time stamped and contains all of the images related to that 
appointment. The visit identifies the type. In some cases, a series of 
appointments may comprise one visit. 

VTO
Visual treatment objective.
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CS Orthodontic Imaging and CS OMS Imag
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d a visit button 2, 15, 39
d/import/export tab 10
obe Reader, installing v
notation tools 32
notations

adding graphic elements 44
changing properties 45
deleting 33
hiding 33
properties 14
showing 33

notations properties toolbar 45
notations tab 11
hive images 18, 40
ows, changing color 45
to Detect Landmarks feature 34
tosizing

images 20
setting defaults 13

ckground colors 13
ghtness tool 25, 42
ttons

add a visit 2, 15, 39
annotations toolbar 6
auto size 20
brightness 25
color 6
contrast 25
despeckle 29
emboss 29

equalize 28
fill 6
flip 31
font properties 6
full screen 3
gallery edit view 3, 7
gamma 26
grayscale 32
gripper 3, 23
hide/show lines 19
hue 27
imaging 1
invert 31
line 6
masking 30
median 29
mirror 31
preferences 3, 10
reset zoom 21
restore defaults 20
rotation 23
saturation 28
sharpen 27
table of contents 1
text 32
tool box 23, 25

C
clipboard, copying images to 35
colors

changing 45
changing background 13

contrast tool 25
customer support, calling 8
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date, changing 16, 39
despeckle tool 29
display/print tab 10
drawing, as part of annotations 44

E
email, attaching an image to 35
emboss tool 29
equalize tool 28

F
flip tool 30
full screen button 3
full screen mode 8

G
galleries

menu of 2
panorex 2
profile and ceph 2
types 2

gallery edit view
button 3
gridlines 7
returning to image chart 7

gallery edit view button, activating 7
gallery views, changing 8
gamma tool 26
grayscale tool 32
gridlines

adding 19
in gallery edit view 7
moving 20
removing 19
setting defaults 13

gripper button 3

H
hue tool 27

image chart toolbar 2
image chart, returning from gallery ed
images

adding to a visit 17, 40
archiving 18, 40
attaching to e-mail 35
autosizing 20
brightness 25, 42
changing orientation 37
changing size 21
copying to clipboard 35
deleting 18
displaying intraoral 2
displaying vertically 41
hue 27
intensity 26
moving 40
panoramic 2
printing 36
printing date of birth on 38
printing multiple 36
printing name of practice 38
rotating 22, 42
selecting a single 7
sharpening 26
side by side 41
types 17, 40

imaging software, accessing 1
installing Adobe Reader v

L
landmarks

defining 48
detecting 34

landscape orientation 37
logo, changing 12

M
MAR 34
masking tool 30
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median tool 29
metal artifact reduction 34
mirror tool 31

N
notices, defined v

O
online documentation, accessing v

P
panoramic, gallery type 2
plus sign, in TOC 2
portrait orientation 37
practice, printing name on images 38
preferences

annotations 14
autosizing instructions 13
background colors 13
basic 10
default export 13
default import 13
global 9
gridlines 13

preferences button 3
printing

date of birth on image 38
images 36
multiple images 36

profile and ceph, gallery type 2
properties

changing annotation 45
document 37

R
records +, gallery type 2
reducing artifacts 34
rotate by degree tool 42

S
saturation levels, changing 28
sharpen tool 26
software, determining version 8

T
table of contents

changing width 1
structure 1

table of contents button 1
tabs

add/import/export 10
annotations 11
display/print 10

text tool 32
thumbnails

displaying images as 41
gallery type 2

TOC
button 2
plus sign 2

toolbars
annotations properties 45
gallery edit view 19, 20
image chart 2, 41
rotate 24, 42

tools
annotation 32
brightness 25, 42
contrast 25
despeckle 29
emboss 29
equalize 28
flip 30
gamma 26
grayscale 32
hue 27
masking 30
median 29
mirror 31
rotate by degree 42
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saturation tool 28
sharpen 26
text 32

tree structure, of TOC 2
types of images 17, 40

U
using this guide v

V
version of software, determining 8
visits

add a visit button 15, 39
adding 2
adding an image 17, 40
changing the date 16, 39
deleting 16
exporting 13
importing 13
importing into a patient 17, 39
moving to another patient 17, 39
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